CHAPTER 8

FINA R TOINT £ DERTE

2T, ROHEBIZOWTHHLET,
¢ Management [P
e Device Administration

* Auto Update

Management IP

Configuration > Properties > Management IP

Management IP ¥ ¢ > RUT, EXa VT 4 77 ITAT U AOEBRIP 7 FLAEIFERY 7 A
TUA— I ET—=RDIALVTXANOFEHIP T RLAZRECTEET, BB Y 74 7 V4 —/LIL, IP
N—TFT 4 TIZBMLERA, ¥X2 VT4 TTIAT UV ATRELINDHE—DIP 27 4
Falb—vat, HHIPT FLAORETY, filSkL LT, Management 0/0 ‘EHLEH A o ¥ —
TxA AP T RVAERETEETH, NI 74y 73D, X —T = A BRTEER
Ao Management 0/0 @D IP 7 KU ADREIZDOWTIE, [ X —T =2 A4 ZAOERE] ML T
S,

ZOT RLARF, VAT A A E—VFERITAAA Y —REDOBERE, ¥X=2 T4 T 77947
VA ETRIEENARNI T4 v ITDOEETLT RLAELTEX2 YT 4 TFI5AT U ARNERT
BI=DIIVHETT, ZOT7 KL RE, VE— MY 7R CbEHATEET,

Z4—ILF
e Management IP Address : & BEIP 7 KLV AZFZHELE T,
e SubnetMask : ¥ 7 Xy h v A7 HHRELET,

EF—FK
WDOFRIZ, ZOWEEFEHTEX2E—FFE2R~LET,

2747 94—IL E—F tX¥aVTF4 a2TFXFb
<ILF
=Ty F Eid TN AVTERXFb SARATL
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M Device Administration

Device Administration

Banner

Device Administration C, X = V7 4 7774 TV AR T A —X 2R ETEET, =
T, ROERIZOWTHBALET,

* Banner

* Boot Image/Configuration

* Console

* Clock

e Device

e FTP Mode

¢ ICMP Rules

* Management Access

e NTP

e Password

¢ Secure Copy

* SNMP

e TFTP Server

e User Accounts

Configuration > Properties > Device Administration > Banner
Banner /SR /L C, YHOBMBEA =Y, 0l Afr, Byiary NP —EFETEET,

N =T HI2E, FET IRy VAT HRAMEANLET, TFAMIATLIzAR—2R
BFEOEFEFRRINET, FTIZTASDM A =T = ATANLET, a~xr R4 inbA
HTEFEHA, F—7 2D $(domain) I L N $(hostname) (L, EF=UT 4 TS T34 T L AD K A
ABBILORA NICESHBEZ ONLET,

$(hostname) 33 & ¥ §(domain) h—727 U EZFEHITH L, FEOI U THFANTIHEELLEFA MM ER
AA A EEEICERTEET, $system) b—27 VEFHAL T HEDILTHFA DY AT L A
NR—ATHE LT —FEEICERTEET,

NP—=PEEATORE. ITZEICAN LET XA FBBEEOA T —DORBICBMENET, TF X
FRZEOHA ., BIRFEE (CR) AT —IZBIMENET, RAMRT7 7 v a A€ U OFENTFT
B, RNF—DESICHIBRIZH Y £H A, ASCI XFOAMEHATE 9, &fT (Enter ¥ —, 2 30F
W) b CTE £,

Telnet £721Z SSH TEXF a2 VT 4 T 7XIAT L AIIT 7 ®ALIZEE, VAT L AFUDBAREL
TR = Ry B—VERRTERNSTZD, N — Ao —T%FRTDHLEEIZTCP EXIALT
F=NERAELTZVTAEEy v a IR T LET,

NF—ZEEZHZ DT, EUT DRy 7 ADNEEER LT Apply 227 U v 7 LET, N —%
JIUT7THITNE, BETDHRY IV AONEEZ 7 VT LTApply 227 U v 7 LET,

VAT A AT HARTIEASDM O HAAF— g REfHTE AN, Tools >
Command Line Interface 7> 55X ECT& £9,
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Device Administration W

E—F
ROFIZ, ZOWEZHEHTEL2E— 2R LET,

2747 04—V E—F t¥aVTF4 a2TFXFb
RILF
=Ty F Ei Y AVTERXF SATLA

Boot Image/Configuration

Configuration > Properties > Device Administration > Boot Image/Configuration

Boot Image/Configuration CEIN LA A —Y 77 ANDOEX2 VT 4 TTIT7AT A% T — |
TEET, Flo, BT a7 Fal—var 77 AV I 2 TEIRTEET,

BHEfA A= L THERHT AR, T A A=Y T AT, o= H 4DFETIRETEE T,
£72 TFTP 34— DA A=V % 1 DFEL, TI06TF A, 2% 7 — s T&E£3, TFTP — 1D
AA=Y T7ANVERETDIHAE, VA MORIEICHEEL T ZE, TFTP =27 7R T
XT AA—Y T7ANEZIDLE— RTEXRWEEIE, VA NTEORIZEE SN A A—V
Tr7ANNT Tyva AU NLE— RENET,

T— "NEBERELRTNVE. NG T 7 v o AFY ORIAICH DHEH /A A—TUMND U AT AR
T—hrENET,

TJ4—ILF
Boot Configuration

* BootOrder: 7— NI HEND ATV A 2= 77 A NVDNEFEERLET,
*  Boot Image Location : 7 — b 7 7 A )VOMEL R GET & X2 EF R LET,
e Boot Config File Path : 2> 7 4 X2l —val 77 A NLVOEHERRALET,

o Add: 7 — FNHHEATA 7T vy a2 AEVELILTFIP V=D T —F A A=V 2 MU &

o Edit: 77 v a2 ATV ELIZTFIP — DA A=Y = M) HfRELET,
e Delete: 77 v a2 AFY ELILITFTP V— DA A= = MY ZBIRL T, HIBRL £,

e MoveUp: 77 v a AEYELIZTFIP — DA XA —Y = MU ZEIRL T, 7— MEF
 EIZBE L X,

o MoveDown: 77 v a2 AEYELIETFIP U — DA A= = b ZFEIRN LT, 7— MIE
FaTICBELET,

e BrowseFlash: 7 — s A A= Ty A NVEIFar 74 Falb—ay 77 A4 NVOEREEE
LET,

ASDM Image Configuration
*  ASDM Image File Path : EEWF T2 7 4 Fal—vary 774 VOEFHTERR LE
ﬁ—o

e BrowseFlash: 7 — s A A—Y 77 A )VEFar 7 4FXalb—vay 77 A NVOEREEE
LET,

ASDM 31 —H 1A K
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Add Boot Image

E—F

ROFIZ, ZOWEZHEHTEL2E— 2R LET,

T7AT 24—V E—F

XT3 TFXFb

L—FvFK

Eif

2787

\'&

RILF

VTR

Configuration > Properties > Device Administration > Boot Image/Configuration > Add Boot Image

T—hr A A=Y = N %T—MEFY A MZEBINT 5I21%. Boot Image/Configuration /X% /L D
Add %7 v 7 LET,

7Ty AEVEFRIXTFTP — DA A=V BRLTC T — M A A= % T — MERFY A b

WZBITEET,

A A= DRXR% NTJT B0 Browse Flash %7 V) v 7 LT, A A—VDEFT&EEE L E9, TFTP

DB, A A=V DOEFFTONRRAEANTHLERDH Y £,

24—=IF

* FlashImage: 77 v 2 77 ANV VAT LADT —h A A=V EBINLTEMLET,
— Path: 77 v a2 77 ANV VAT AIHDT—F A A=V DORAERELET,
e TFTP Image : TFTP — "D 7 — k 4 A= & @R L TEMLET,

— [Path] : TFTP H— DT —h f A= T 7 A NVDRRAEANLES, —1DIPT FL
AH|ELET,

e OK:ZEHEEHMZLT,
e Cancel : ZEAZMHIC LT, EHATO/XRKVITRKEY £77,
e Help : FfHIfEHRAE LR LET,

E—F

ROFIZ, ZOWEZHEHTEL2E— 2R LET,

ERTO SRR 97,

T7AT24—IL E—F

t¥aVTF4 a2TFXFb

=Ty FK

=il

2787

\'&

RILF

VTR

l ASDMa1—% A/ F
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Clock

Device Administration W

Configuration > Properties > Device Administration > Clock

Clock X3V T, AHfEMAEZ X2 VT 4 T7I7A4 T ACFEHTRE LET, HZlI% ASDM A
AL T4V RUDTEDART —HANR—ZERENET,

2N FaAarTFXFARN BT—RFTIEZ, BEIE AT L 207 4 Fal—2 a3 b ORIZEEL TS
W,

NTP h—NZFRH L THRA%E XA I v ZIZHET HI2IE, NTP X%V E S LT NTP — 30
L ST 5 & Clock TRETRE LM Z 20> T EEXTEXET,

Za14—ILF

* Time Zone : FpfilH 1%, @872 5E% GMT ([ZBINE 21X L TR E L £ 4, Eastern Time.
Central Time, Mountain Time. %7213 Pacific Time ZFFfilHr & L CEIRT A L, 4 HDOHE— HIE
HOFRT2 KL 10 A D& AWE R OFRT 2 RRIC RS B BIICERE S E T,

S

GE) ®xX=2VUT+4 T77IAT7AORMHE LT T, AT U V= SSM & D
WRey TENDHEERH Y £,

e Date: HfI A ELET, VA MPDOFEL AMEZBIRL T, WL F¥—DHRE7 Y v 7 LET,
o Time : FF%1% 24 FFRHI CTRROE L £97,
— hh, mm, BEWss Ry 7 2 : B, 4. WE2RELET,
 Update Display Time : ASDM V t > RU DL FORRIEZNERH S ET, BERZIT 10 B
TlICHBIEHR INET,
E—F
WORIZ, ZOKBEEHFHTEL2E—FERLET,

I7A470+—IL E—F XalF4 aVTFRb+
<ILF
L—Fy K iR TN AVTERb AT A

[ oL-10106-02-J
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Console

Device

Configuration > Properties > Device Administration > Console

Console /X% /)L C, HFH o Y —)LOFRRIERE (HEA) ZEECEXET, 22 THELREN
BT e, 2= MEHBNIC Yy N T LET,

Console Timeout 7 X% 2 h AR v 7 ZZHEMEZ AT LET, SR LARAWVIESIZ0EZAN LET, T 7+
v MEIZ 0 TT,

E—F

ROFKIZ, ZOWREEZHEHNTELE—FERLET,

tXaTF4 a20TFXFb
RILF
=Ty F &R v AVTERXF SATL

2747 24+—)L E—F

\'&

Configuration > Properties > Device Administration > Device

Device SRV T, RA M E RAL %X VT4 TTITA4A TV RAIRETEET,
RARMFAT FIAL DT T MIERENET, ZOKRA ML ST, HEOT A 2
LDty a Y EMST DA, Ay REANT LN EICIEETEET, A MiFv =2
Th A=V THHEHINET,

VAF AT HEFAN T— RTHE, VAT LETAN—ATRELIZAA MBRTRTOar T ¥
FDa~vr RIAy a7 MIRRENET, a0 TFANTRELIZAA ME, avr K7
A VNCFTRES, AT IR T AT a b H Y £,

X2 VT4 TTITAT P RT, RAL A e REMAIEREFE LTEMLES, 2L 2iE K

A A 4% lexample.com] (ZEEE L. syslog h— NZHKEH% [jupiter] ZHETDHE. X2V
TA T TITAT URE, ZD4HI%E Tjupiter.example.com| [ZFRE L E9,

24—ILF

e Platform Host Name : RA MAERTELET, T 74V NDEANAIE, 7Ty b7 +—20
I K> TRED £,

e DomainName: NKAA VAERELET, T 74/ D KAA 41, default.domain.invalid T
‘j‘o

E—F

WDFRIZ, ZOMREEELFHTE2E—FE2RLET,

T7A4F724—)L E—F tXxa)F4 aVTXRFb

RILF
V=T F Eif DU AVTFRb DRAT L

l ASDMa1—% A/ F
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FTP Mode

ICMP Rules

G¥)

Device Administration W

Configuration > Properties > Device Administration > FTP Mode

FTP Mode /X% /L C, FTPE— K& 7 VT 4 T ETIEINRNy VT ICRETE ET, X274 77
FGAT UVANA A=Y T7ANVFERIFar 7 4 Falb—vay 774 )0% FTP b— N7 v
2—RL7ZD, FTP V= I\nhbHHX o ra— RTE5X512R0ET, Sy T FIP 7747 2 K
I, v ha— R T AR AT L DEBTEET, VN3 T B R TT X B
BEDFLIEITI D | FEDHRDOZAERFIIAR — MEFIISELET,

J4—ILF

* Specify FTP mode as passive : FTP € — K& 7 77 4 T E 73Ny VTIZRE L E T,
E—F

WORIZ, ZORBEHHTELE—FEZRLET,

2747 04—V E—F XT3 TFXFb
RILF
=Ty F EiR oL AVTERFb SARATL

Configuration > Properties > Device Administration > ICMP Rules

ICMP Rules /X% /L C, ICMP b—/)V 7 —7 W% KR, BX=2 VT 4 77747 AT ICMP T
TIRATHTRTORA MNEREFR Y MU= OFA | HEGEZHRTELET, TOT—T7 /L THA
FEZIEFRY U= %8B, BETEHE, ¥X2 VT4 TS IAT L ACEEENTZICMP 2 v
U EHAEIIEEETE T,

ICMP v —id, BX 2 VT 4 TTITAT VA AL E =T A RZICMP 77 4 v 7 I3ERE LT
BAEORIEFEEFR T LET, ICMP 2> b —L U XA MRRBRES N TWHRWES, X2V T ¢
TITIAT L AIRA L Z—T 2 A ABEFD, AV F—T 2 A AZEHEEFELZICMP 57 4 w7
EITRCHFAILET, 7L, 7740 T, 82V T4 77947 A T7 2 —RE ¥ X b
7 R A~ ICMP = 2 —ZRIZEE LER A,

Security Policy /XX /L CICMP N7 7 4 v 7 DT 7B A NV—)VEFRET D&, 5D 5 —T7 =
AAPRESN TN T EXR 2T 4 TTIAT Ay — M TEET,

ICMP DEFEARGEA v E— Z A 7 (type 3) DHEFRIT, FIZFFAICT 2 Z L 2 BEID L ET, ICMP
DBFERFEA v — V% EET S & ICMP O Path MTU Discovery #BE23 T ¢ & — 7 /L1720 IPSec
BELOPPTP N7 7 4 v 7 MEILT 255 03% D £7°, Path MTU Discovery DFEMIZ DV Tldk, RFC
1195 B X UYRFC 1435 2B L TL 72 &0,

ICMP 2> he— L VA NERETDE. . EFa2 VT 4 TTI7A TV ATIIROII B LM%
ICMP b7 7 ¢ w7 I\ZHEMA L, BFERIC T RCTEERLET, Lo T, m—FK L= b
URFFAIOEEIL, ICMP 37w MIZOF LB EINET, BOIC—F L= M) BMEROE
BERIFT B LA TZEAIT. ExX 2T 4 T T7A4 T ATICMP 37 v MIEREE S 1L, syslog
>< /Jz UHRHAEIHET, FISMIICMP 2 bu—L U R RBREESNTCORWEETT, 0

[ oL-10106-02-J
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Za—ILF

e Interface : ICMP 7 7 ZARH R EINDI X2 VT 4 TTITA TV ADA v H—T =4 A%—
EFRRLET,

o Action: EELE Ry NI —Z FHIEZFRA FNDICMPSEA v E— ORI AELEE R R LET,

e TP Address: 77 B A& /BT HFR Y U=V FFHIEIEAFDIP T RLRAE—EFRRL
7,

o Mask: 77 B REZHATHEy NI —T7 F/-1E3F A MCEEMT Ny NT—F <R
EmERLET,

e ICMP Type: /L —/LZHEHT 5 ICMP * vt — A 74 —EFRLET, £ 8-1 (TRT ICMP
BA TR R—hENET,

e Add : AddICMPRule ¥ A 7 12 7R v 7 ANRFE/RE I, HHO ICMP V— L% T — T )LD Fx#
B TEE£7,

+ Insert Before : ICMP /L — /L &8N D /L— /L ORNZBIN L £7,
* Insert After : [CMP /L — /L2 @&INFDO/L—/LOBIZEBMLET,

e Edit: Edit ICMPRule ¥ f 72 /7R v 7 ANERIN, BIRLIZAA NERITRY hU—7 %
METEET,
e Delete : BIR LKA NELITRY NU—7 ZHIBRLET,

= 8-1 ICMP 24 UF3)L

ICMP 247 |UT3)L

0 echo-reply

3 unreachable

4 source-quench

5 redirect

6 alternate-address

8 echo

9 router-advertisement
10 router-solicitation
11 time-exceeded

12 parameter-problem
13 timestamp-request
14 timestamp-reply

15 information-request
16 information-reply
17 mask-request

18 mask-reply

31 conversion-error

32 mobile-redirect

ASDM 21— 4/ K
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E—F

Device Administration W

ROFIZ, ZOWEZHEHTEL2E— 2R LET,

T7AT24—IL E—F

t¥XaVTF4 a2TFXFb

TILF
L—Fvy K Bl SUgIL VTR SRT L

Add/Edit ICMP Rule
Configuration > Properties > Device Administration > ICMP Rules > Add/Edit ICMP Rule

Add/Edit ICMP Rule % 4 712 7R v 7 2T ICMP /b —/LDBIETZIIEENTX £4, ICMP /L—
NTE. BF2 VT4 TTIAT LV ANDICMP 77 B ANHA /S SNDHFA NERITR Y B
U—7 D7 RLAZTRTHEETEET,

24—=IF

e ICMP Type : L—/LZ@HTHICMP A vt — Z A F24EELET, % 827557 ICMP #
A TR R—hENET,

e Interface : ICMP 7 7 EARH A ENDHEX2UT 4 TTIFAT LV ADA X —T = A A%k

BLET,

e IPAddress: 7 7 B A EHA [ EETDHFRy hU—27 F72FHRA FDIPT FLAERELET,
o AnyAddress : {I§ELT1-A L HZ—T 2A ADT_XTOZET RLRAILT 7 varvamlLET,

o Mask: 77 B REZHFATEHRy hT = 3R R MCEEMTFONEZR Yy FT—F <R 7
EREELET,

o Action: ¥ EELTE Ry NI —Z FHIZFRA FNDICMPSEA v E— ORI AELEZIEE LE T,
— Permit : FEEL/-FAA MERIIR Y NU—2 L, T RBRFAIENZA LV H—T A AD

ICMP 2 vt — %R LET,

— Deny: fiELLAAX MNELIIX Y NT—2 & FryZInicA 2 —7 A 2D ICMP
)( ‘7‘[?*17%“552 Lij—o

5 8-2 ICMP 247 JF35JL

ICMP 24 UTsn

0 echo-reply

3 unreachable

4 source-quench

5 redirect

6 alternate-address

8 echo

9 router-advertisement
10 router-solicitation
11 time-exceeded

12 parameter-problem
13 timestamp-request
14 timestamp-reply

15 information-request

[ oL-10106-02-J
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%z 8-2 ICMP 247 JT35)L (=)

ICMP 247 735

16 information-reply
17 mask-request

18 mask-reply

31 conversion-error
32 mobile-redirect
E—F

ROFIZ, ZOKEZHEHTEL2E—FE2RLET,

T7A4F724—)L E—F tXxa)F4 aVTXRFb
<ILF
L—FvFK =B 2% AVTXR b RT A

Management Access

Configuration > Properties > Device Administration > Management Access

Management Access /X F/L T, BEREX2 VT 4 AV F—T 2 ADOEHT 7 ¥ A% A F—T IV
| T A= NMIEV R, X2 VT4 TT 74T AOEHEMELFEIT X7, BT /&
AHxAR—=TNWICT HE IPSec VPN b U RV TEEINZIP T FLRAEFONEHA v F—T A
AT, ASDM ZEITCEET, ZOMELMENT 25513 VPNa2EXxFa2 T 77I7A4T7 A
TREL. A E =T oA RAHEAF I 7 IPT RLRAFE DB CEFEALES, & 2E, &
X2 VT4 TTIAT UV AZAENPL VPN FA T N CT 78 AT DRI GAR0EX=Y
TABEHTELLET,

Z4—ILF

* Management Access Interface : EX =2 V7 4 T I TV ADERA X —T 24 AEFEEL
*9, None DA, BT /7 VA IIT 4 =TV T, ZHEIT 740 T, EHET 7R
EAF—TNMITHINE, A v E—T oA ADEX a2V Tt kb@Em<#EL, W1 ¥ —
TrxARILET, ~EIZ 1D, v H =T A AT OEHT VB REA X—T VI TEE
o

EF—F
WDOFEIZ, ZOWELFHTEX2E—FERLET,

774724 —I)IL E—F tXaT4 aVTFXb
TIF
L—FvFK iR 2N aVTFR B ORT LA

ASDM 21— 4/ K
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NTP

Device Administration W

Configuration > Properties > Device Administration > NTP

NTP SV T NTP = _ZER LT, ¥Xa VT4 TTIAT U RTRAE LA T2 v 71T
ETEXZET, BIIXASDM ALV T4V RUD FEHDAT —H ANRN— IR REINET,

Clock 7SRV CFREHRE LIZEZNTT T, NTP — "0 b g Shimglic k- T EEX SN E
—aﬂo

LET, ZDOX)RKEEIL. CRL DRGER CIEfER A A b AX T HE0EAR Y, AN EE
REMETHKEC R £, fﬁ%w) NTP P NEBRECTXET, X2 VT4 TFI5A4T AT
BTOBEENSY—REBINL, T—FEEEOREICLET,

J4—ILF
e NTP Server List : T I TCW5H NTP — &R LET,
— IP Address : NTP — D IP 7 RLAZRLET,

— Interface:NTP /X7 v FDFEEA LV F—T 2 A ADRREESNTWIEEE. ZTDA L F—T =
AAERLET, VAT AIA LV F—T = A ZABTRWIGE ”SEEZ /TﬂEX kA=
T A AMERENET, AV F—T 2 A ADNZEADEE, ¥X2 VT4 TTIAT A
WERT LT 74V EOEBRI L TXARN A U F—T oA RAFI N—T 4 VT T—TNIZ
LoTHREY 7,

— Preferred? : = NTP Y — MBIV — )0 E 5 )k Yes £721X No T/RLFE 9, NTP X
TNITYALEFEH L TROBEOE WY —NZHBIL, 2OV —NCRBLET, BE
BRI CBETHIUL, BV —R_"EFEHLET, 7L, BEV— "LV IEEE20ITHEED
EWY =B HLGEE. EFX2 VT 4 TTITAT L RATEDOREEDOE N — 2 L
F1, HEE X2 VT4 TTIAT AT L OVEEOR WY — "2 L, EL
P — OB EPMEITIVTFEA L EEA,

— Key Number : Zif¥—D D FEEEZRLET,

— Trusted Key? : % —73 trusted key 72 & 9 2% Yes £721X No TR L 7, trusted key 721F 28
Huuﬂzémi—aﬂ

e Enable NTP Authentication : T X CODH— OFEIEE A F—T M LFET,
* Add: NTP H—ZiBiL £7,

* Edit : NTP — S ZfREL £7,

o Delete : NTP — ZHIER L £3,

EF—F
WDOFEIZ, ZOWELFHTE2E—FERLET,

T7470+—IL E—F XalF4 aVTFRb+
TILF
L—Fy K ik SN AVTEFRb RT A

[ oL-10106-02-J
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Add/Edit NTP Server Configuration

Configuration > Properties > Device Administration > NTP > Add/Edit NTP Server Configuration

Add/Edit NTP Server Configuration % 1 7 2 77K 7 AT, NTP —"ZBIME - IImETEET,

J4—IJLF
e IP Address : NTP#— XD IP 7 L ZAZHREL £,

e Preferred : Z DY — NZELYP—NICERELET, NTP X, 713 Y XAZFER L THRLKEE
DENY—R_EHBI L, ZOV— NZRBLE9, BESFE UREChHIVUL, B — %
ALET, 2720, BEY— "I IE20ITBEEOREN— BB 5581F, EX=2V T4 7
TIAT LRI TEOREEDE N —_"EHHLET, 213 X2V T4 7794 TR
EEVBEOES WY —NEHEA L, BV —"ORBEMRTIVUXER L EEA,

e Interface : NTP /X7 > FDREA LV X —T =2 ABRELET, V=T 4T T—TNMZ LD
TIANN AT =T 2 A AEEETEET, VAT ALV F—T A ANR2WEGE, EFH
AUTXAMNAE—T oA ABNEHINET, BEI TR FHTEM 0 4—T =
A R) BERTLHEAIT, BEWDZHIZ None (F7 4V~ A F—T x4 R) ZFEIRLT
<&V,

* Authentication Key : MD5 F&FEC NTP — R L @ETLHHAIC, BiEXF—DO7 M Ea— %
RELET,

— Key Number : i8iEF—DF— ID #FELE T, NTP H— D7y hHZDOF—ID %
T 2A20END D 9, O —0F— ID RHREFHOBEIT, VA M DBEIRTE
1, ANTDHEET. 1 ~ 4294967295 OHFPFHDEZFEE L £,

Trusted : 2D % —% trustedkey & LTCRELET, ZOFT = v IRy 7 AEF AT LR
L. BFESLEE A

Key Value : it nJ‘.EA;V %T_’ 32 jC%U\Ij‘?“C %Ljﬁﬁ—
— Reenter Key Value : ELWX—ThHdH I 4R THZH, F—% BEASILET,

E—F
ROFIZ, ZOMWREELEHTEL5E—FE2RLET,

F27A4F7 94—V E—F XT3 TFXFb
RILF
=Ty F Bl o AVTERXF SARATL

Password

Configuration > Properties > Device Administration > Password
Password /X% /L C, B A NRAVU—RLAX—T N RXATU—RERETETET,

X2 UT 4 TTTAT 2 AIZEERE LT Telnet £721XSSH B> v a VEFITLTWAHEE, vl
AV AU —RTEXECE— RFIZT 7 EATEET, (Telnet 721X SSH DT 7 & A2 — 587
ERETHE, 2—VFIHATONRARAT—REFHL, /A4 RRAT—REZFEHALETA, AAA
Access NIV ESILTLZE W),

AF—T N RAT—=RTrI AT, FHEEXEC E—RIT7T78ATEEd, £/, 2o
AU—RE, T 74NV F 2—=FLTASDMIZT 7 B ATHEAICHEHALET, T 74/ b 22—
PAITZEAIZR > TOET, T 740 h = —F 413 User Accounts /X% /UIZ lenable 15) & FKR X
NET UX—TN T 7R Z2—PRALZERET DL 2—FIXAFO AT —RFEMHEH L, A
F—T N RAT — REMH L £ A, AAA Access /S 7L E SR L TL 72 &0, & 52, HTTP/ASDM
TR ACORBIEERETEET),

ASDM 21— 4/ K
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Za—ILF

Enable Password : % —7 /L NATU— RERELET, 7 7 4/0 b TIFEAIZR>TWET,
— Change the privileged mode password : f *—7 /L /XA U — R&ZEH L E 7,

— Old Password : ZEHERID/NSAT— REATTLET,

— New Password : ZHEZD/NNAU— K2 AN LET,

— Confirm New Password : ZH LD/ RAT — REfERLET,

Telnet Password : @ 7'+ > NATU—REFRELET, T 74/ FTiE lciscol] T, 2D
=T DR v 7 AL Telnet Password (2722 CTWET /N, ZD/XAT— KT Telnet & SSH IZ7T
JEATEET,

— Change the password to access the platform console : 2= 7 A . /XA T — REEHTLET,
— Old Password : ZHEETONAT—RF&E AN LET,

— New Password : ZHEEZLD AT —KEZANLET,

— Confirm New Password : ZEZKD/NA T — REMERLET,

EF—F
WDOFEIZ, ZOWELFHTEX2E—FERLET,

T7AT 24—V E—F

t¥a)T4aVTFRAF

TILTF
=Ty K b ) gL aAVTFFR b SRTF LA

Configuration > Properties > Device Administration > Secure Copy

Secure Copy /SR T, EXa T4 T 7ITAT L ADEXaT ab— ="l x—TNIZL
F9, SSHEHMT2EX2 VT 4 TTIAT UV ADT VB AZFAESNIZI T4 T 2 METB,
X T AR a LT £,

HIREIE
tF a7 abt— = "OEEL, ROFIRFELH Y £7,

P—=NTEF a7 aE—EROZTANEK TII TSI, EBITEEEA,

P=NiE, T4 V7 NIDOREEYR— ML TWERTA, TOD, YE—N 7747 8T
ITEATEX 2T 4 TTITAT UV AONET 7 A VBRITTEEHEA,

P—NiE, NS —Z P R—F L TWHEEA,
Y=L, VAN RI—FRKEVR—=—FLTWERA,

SSH N— 3 v 2 TR T D121, EX 2T 4 7T I9A T ADTA A
VPN-3DES-AES #RES LB TY,

Z4—ILF

Enable Secure Copy Server : X =7 4 7774 T U ADEFaT at— h—n_% 1 x—
T LE T,

[ oL-10106-02-J
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SMTP

SNMP

l ASDMa1—% A/ F

E—F
ROFIZ, ZOWEZHEHTEL2E— 2R LET,

2747 04—IL E—F t¥aVTF4 aTFXFb
RILF
=Ty F EiR v AVTERXF SARATL

\'&

Configuration > Properties > Device Administration > SMTP

SMTP /S /LT, FEAELTZEHEA N 2B FA— /L TEIT D SMTP 2 747 & baA X —7 )b
/| T4®—=TMITEET, ZTTEMTEDLDILSMTP =D P 7 L AT, A7y ar b L
TN I Ty T =D T FLALRETEET, ASDM T IP 7 RLARHEDNE 5 nk
FrzvZ LEHA, TRVAZEHRICASILTLLIEE N,

WL G5 D EL A —/V T KL RIL, Configuration > Properties > Logging > Email Setup T%7E L
iﬁ—o

Z4—ILK
¢ Remote SMTP Server : 77 A <1 SMTP $— bt &) SMTP — " ZHELET,
e Primary Server IP Address : SMTP —/ "D P 7 KL 2&2 AN LET,
* Secondary Server IP Address (Optional) : £ % U SMTP %— "D IP 7 KL AZ AN LET
(A7Fvav),
E—F
WDOFIZ, ZOWEZHEHTELE—REZRLET,

774724 —I)IL E—F tXalT4 aVTFXb
TILF
L—FvFK iR 5L aVTFR B ORT LA

\"

Configuration > Properties > Device Administration > SNMP

SNMP XX NVT, ¥X 2T 4 77534 T7 A% G ry NUV—27&HE 7w b2/ (SNMP) &L
AT = a VPLERTELLIICRETEET,

Sy NI — VBT —2 g% PCERIIV—V AT —2 g THEITL, AL vF, L—F, &
X2 UT 4 TTIATUARE  SESERIATDT AL ADAT —H AL~V A BB IS
72 5% SNMP TERTEX E 9,

SNMP O S

e Management station : PC £721IV—7 27— 3 UV CETEINDLI Xy NT—TEBEAT—1 3
Y TT, SNMP 7' h LA LT, EHHGRT N AOET — 2 R— 22 FHLE T,
N R Y 2T OREERPEENLERA R FORXA v —U b ZETX 4,

OL-10106-02-J |
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e Agent: SNMP 2> 7 XA MCik, BHEAT—Va N2 7772 h ¥X2 VT4 7794
T ATEHNET D SNMP =— = > RS =T ) 4,
e OID:SNMP HMTIZ, ¥ AT L &7V =2  ID (OID) ERELT, BHATF— g N

SNMP =—V =2 bM3BH DRy NU—7 TRAL A —BIZH LY 2—Fizmynbd ki
ERUEROBETLER R LIZD LET,

e MIB: =— = }|X Management Information Databases (MIB; FHFHRT — X X—R) LFEE
NAHMERESF — ZFHEE R LE T, A EHAT— g VICEREINET, MIBIZ., & v
MoBEfgi, =7 — Ao Z . Ny T ORI, 72— F == ZAT—F R E DGR
ZIWHELET, MIBIZRGZLICERISN, BFEOR Y NT—27 T ZATHEH I D i)
m7a hant =Ry =T HKES MIB IZERSNLTWET, SNMP BELA T —1 3 Vinb
MIB #ZM L7720 HEDT 4 —/V FETZERLIZY T&EET, —#HOT7 SV r—a T
%, BEHMTMIB T — ¥ 2EET 2560850 7,

o Trap: T—Y = MITT—2 &b ERLES, Vo 7o, Vo y X syslog A
RN ERNT /7@’Hﬂibt77“-ﬁ7kﬁ:ﬁ‘§§i'§”5}: T—Vxr MIFESNTZEHA
T—=va NI EBIZBEMLET, ZO@mEISNMP F T v T E LR E T,

SNMP

VAa@OMIB 7 7 A B ILROID 12OV,
http://www.cisco.com/public/sw-center/netmgmt/cmtk/mibs.shtml % 2B L T < 72 &V, OID I&, KD
URL 2H ¥ 7 rm— K452 L6 TEET,

ftp://ftp.cisco.com/pub/mibs/oid/oid.tar.gz

MIB 4 7R—
X2 UT 4 T IAT v A1E, RO SNMPMIB #HR— K L TWET,

X2 VUT 4 TTTA4T AL, CiscosyslogMIB D7 T 0 7 AR—FLERA,

e MIB-II ® System 7 /L —/" & Interface 7V —7"% 7T 0 7 T&ET, MIBOT TV T
ERT7 v TOREBLEITENET, 770V LF BHAT—Ya b5 MIB Y ) —0
snmpget X° snmpwalk Z 54T L, HZRETH I & T,

e Cisco MIB # L U Cisco Memory Pool MIB #ffi Fl C& £,

s ¥FX2 VT4 TTITAT AL KD CiscoMIB ZH A — LT EEA,

* cfwSecurityNotification NOTIFICATION-TYPE

* cfwContentInspectNotification NOTIFICATION-TYPE

e cfwConnNotification NOTIFICATION-TYPE

* cfwAccessNotification NOTIFICATION-TYPE

* cfwAuthNotification NOTIFICATION-TYPE

e cfwGenericNotification NOTIFICATION-TYPE

SNMP CPU {ERIkR

tx2VT 40 TTITAT AL SNMP ZF M35 CPU R DE=4 1 7 %I AR— LT
WET, X2 VT4 TTTA4T7 2 AD CPU M ARILA BT 2B, HP OpenView 72 £ SNMP
FBEY 7 Ny =T ERATAE, Xy N VERBEREET T U EERTEET,

Z OFEREIE. Cisco Process MIB (CISCO-PROCESS-MIB.my) @ cpmCPUTotalTable @ ¥ 74— h#EE
X o THARENTOET, MIB IZIEIZ 2 2T — 7)1 (cpmProcessTable, cpmProcessExtTable)
73%%@&'?"75\ AEDY Y —=ATIEIHFR— SN TWERA,

[ oL-10106-02-J
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cpmCPUTotalTable D&ATIZIE, CPU DA VT v 7 ALROAT V=7 MREENET,

MBATSx) +4 B

cpmCPUTotalPhysicallndex |Z A7 =2 FOfEIX 012729 F£§, Entity MIB O entPhysicalTable
of Entity MIB 2 tX¥ =2 U 1 77747 AD SNMP =— = > |
MY R—F L THRNZDTT,

cpmCPUTotallndex ZOFT V=7 FOfEIX 01272V £ 97, Entity MIB @ entPhysicalTable
of Entity MIB #2¥ =2 VU7 4 77747 AD SNMP =— = > |
WY R—F L THRNZDTT,

cpmCPUTotal5sec RS O CPU ko b v—
cpmCPUTotal Imin BT 15/ CPU &k v v—=%
cpmCPUTotalSmin AT 5 4310 CPU 2140 b Y —

GF) BEORX2VT 4 TTI9AT A N—RUxT 77y 74 —AFH— CPU EiIFHA—FL
TWBe®, EX=2UT 4 77 T4 7 2 AMRIKT cpmCPUTotalTable 13 1 177517 C, A T v 7 A
ITEIZ 1720 9,

[EATD 3 BFROEIL. show cpuusage 2~ > FOHIIME & [E T T,

WOHF LWMIB A7 =7 b cpmCPUTotalTable IZ2H D B, EX =27 4 TS IF3AT AT
FYR—FnTHEE A,

e c¢pmCPUTotal5secRev
¢ cpmCPUTotallminRev
e c¢pmCPUTotalSminRev

Za4—ILF

¢ Community string (default): N2V — K& AJ)LET, SNMP EHAT — g TExa VT4
T IIAT LV ATEREEETDHEE, ZORAT—FRE2HEHLET, SN\MPD a3 2=5 ¢
A RY 71X, SNMP BELR T — v g V EEHMR R Y NU—7 ) — R THEA SN DB
WTT, ¥X2 VT4 TTIAT LV RINRAT— REBR LT, %395 SNMP ZERNEZ)
MEIMERELET, NAT— KX, KXFENLTEREAENDEK 32 XTO/TT, A
R—RIfFEHTEEFA, T 740 ME Tpublic)] T3, SNMPv2c Tix, FHAT—va =
ElBDOalza=F 4 ANV U ERETEET , A2 4 ANV U IR EOERAT —
TAaVIHLREINTWRWGS, ZITHRELLMENT 740 M LTEHRHIRET,

e Contact: EX=2 T4 TTFIATLVADVAT MEBREOLIE AT LET, TF A NI
K127 SLFT, RXLFENLFERPLET, A=A IFHTEETA, g HAN—2
1T 1 MDD ZAR_R— R ITHED BIVET,

e Security Appliance Location : ¥ ¥ =2 U T 4 77T A4 7 ADGEERETE LET, TF A Mik
K127 LFT, RELFENLTFERRPLET, A=A IEHTEEI0, HigT 2 A=A
X IHIDAR—=RZHED HILVET,

* Listening Port:SNMP F 77 4 v 7 NEFEINDLF— NEIBELET, 7 7 4/ ME 161 TT,
* Configure Traps : X FARETLH L, SNMP 7 v 72 L TEMTE XS,
* SNMP Management Station 7~ > 7 A

— Interface : SNMP HHEAT — a VBNFET L EX2VT 4 TTITAT UV ADA U H—
Tz A AL ERRLET,

ASDM 21— 4/ K
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— IP Address : SNMP #H 27— g VD IP T RLAZERLET, X2V T4 7774
TURAFIDOT FL RS TR T v AR MERELEZY, BERELIIR—-V 7%
ZELEY LET,

— Community string : ‘BHEA 7 — a3 Talia=7 1 ANV TEZEELRVEGE.
Community String (default) 7  —/L NOREMAFEH SN ET,

— SNMP Version : FHAT— 3 NIHESIN TS SNMP O~V g U EFRLET,

— PollTrap : ZOEHAT = a VOBEIRNERRLET, K=V 7DH, FT7 7D
B, D=V T L Ty TR ET, "=V 7L, —EFRETHRIRELEEIND
FHAT—va v DEREEX 2 VT 4 TTITAT VAR OZEEVWET, FF v
BEERTETDH L, FE LR syslog 4 X2 MREEINET,

— UDP Port : SNMP 7R A h® UDP R— FTY, 774/ bk R— FE 162 TY,

Add : Add SNMP Host Access Entry 2358& . IRD7 f — /L RERETEET,

Interface Name : HEAT — L a3 URGFETHA VX —T oA AEBRIRLET,

IP Address : HEEAT—L a VD IP T RLAZBELET,

Server Poll/Trap Specification: Poll 72/ Trap Z##IN L T M 2 BINTHZ EHTEXET,

UDP Port : SNMP "2 k@ UDP "— hT9, 2D 7 4 — /L REHETH L, SNMP KA hD
T 74/~ UDP A — b & 162 B EEXINET,

Help : M@ 2R R L ET,

Edit : Edit SNMP Host Access Entry % 4 7 2 7R v 7 ARE, BMOHBEER L7 4 —/ K
NERINET,

Delete : S8R L7-IHB ZHIFR L £,

EF—FK
WDOFRIZ, ZOWEEFEHTEX2E—FFE2r~LET,

F27A4F7 04—V E—F t¥aVTF4 a2TFXFb
<ILF
=Ty F Eid oL AVTERXF SARATL

Add/Edit SNMP Host Access Entry

Configuration > Properties > Device Administration > SNMP > Add/Edit SNMP Host Access Entry

SNMP B X 57— 3 > MiEM
SNMP EHIA T — g VEBIMNTHI2IE. WOTFNEEZFEITLET,

o b=

Add 27 Y v 27 L, SNMP Host Access Entry ¥ 1 7 0 7R v 7 2% & 7,

Interface Name 7> 5 SNMP EHAT — 2 g U INFETDHA v X —T = AR L FT,
BEAT—3 2 OIP T KL A% IP Address (ZA ) L ET,

SNMP 78 A D UDP R— h & A LET, 774/ T 162 T,

SNMP 75 A k@ Community String XA T — RK&EZ AN LET, FHAT—varCTaia=74
A KU > T EFEE LW 54 SNMP Configuration [ ¢ Community String (default) 7 ¢ —/L
RICERE LT EREH S ET,

Poll £72/XTrap %27 UV v 7 LCRIRLET, MAFZEBRTLIEHTETET,

[ oL-10106-02-J
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8-18

7. RORZ %) v rFTDHE BHAIONSKIVITRED 7,
e OK: ZHAHZIL T, HATO/SKMTED £,
e Cancel : ZHEAZMHC LT, HATO/ SRR £,
e Help : FFMIfEHMAZ LR LET,

SNMP EEXF—L 3 vDESE
SNMP BEBER T —3 3 U ERET HICIE, ROFIEEZFEITLET,

1. SNMP /X% /L CSNMP FHAT— a3 7—7 /DU X NABZEIN L F7,

2. Edit %7 VU v 7 L. Edit SNMP Host Access Entry % B & £,

3. Interface Name />0 SNMP FHIA T — 2 a VN GFHET DA v F—T = A AERRLET,

4, FEIHAT—2 a3 DIPT KL A% IP Address (AT LET,

5. %mpﬁxb@Cmmmw&mngv~F%AﬁLiTo%@z%~v5yﬁni;:%4
A Y 7 HEE L2V E . SNMP Configuration [ © Community String (default) 7 ¢ —/L
RICERE LT EREH SN ET,

6. SNMPAZ F®DUDPAR— b2 AN LES, 774/ ME162 TY,

7. Poll £72iXTrapZ2 27 U w7 LCEIRLET, MGHFEZHERIRTHZELTEET,

8. SNMP O NN—V g U EEIRL £,

9. WMORZ %IV vy $ 5L, ERIONFMIRED 7,

e OK: EHEEZAMZLT, HATO/NNFIIZEY £,
e Cancel : BEAZ ML T, EATO/SRMITEY £97,
e Help : FfHIfEHMAZLRLET,

SNMP EE X F— 3 Y DHIk
T—T N5 SNMP EFAT —3 g U AHIBRT %, ROFNEEZETLET,

1. SNMP /X% /L CSNMP FHA T — g 7—7/VOHEBA Z BN L £,
2. Delete 7 U 7 LET,
Z4—ILF

e Interface name : SNMP ;R A N FEETHA VX —T = A ABERLET,
e IP Address : SNMP R A D IPT RL A AN LET,

e UDP Port: SNMP 7 v 77— FDEFHICTH UDP A— b2 AN LET, T 740 bt 162
T,
e Community String : SNMP % — D2 I2=7 44 ANV T EAHLET,
e SNMP Version : SNMP O/ 3—0 5 218N L E 1,
* Server Port/Trap Specification
e Poll: R—VU U IEREEELET, A=V 7Lk, —FEMBTRIELEEINDIE
AT —2a v DEREYX2 VT 4 TTITAT VUV ARNEOZ LBV WNET,
e Trap: N7 v I EHREXELET, T v T ERETDHE. BA LT syslog A X b A%k
fg&hnEd,
e OK:ZHEAEZHMHILT, HATDOSRMIRY £,
e Cancel : ZHAMHIZ LT, EATO/ SRR £97,
* Help : FEMIERAZR T LET,

ASDM 31— JA F
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E—F
ROFIZ, ZOWREELEHTEL5E—FE2RLET,

F27ATF72+—ILE—F XxalTFs aTEXEb
E4%a
=Ty F EiB 2N | aAVTXR b VAT LA
SNMP Trap Configuration

Configuration > Properties > Device Administration > SNMP > SNMP Trap Configuration

X

NG TWET IOV T ERRY FHZER LR TH, V7 Ty 7 Vs X syslog A
Ry N EREEDA R MRFAET DL FEHUNRT AN ANGEHAT — a2 222 b
WEESNET,

YX2 VT4 TTIAT LV ADSNMP 47 V=27 MID (OID) 2, ¥ ¥ 2 VT4 TTFI7AT A
MBIEFEIND SNMP A X MIERREINET, BXF2 VT4 TTIF3A4T U AD VAT A OID I,
SNMP @A X2~ FF 7L SNMP @ mib-2.system.sysObjectlD |ZFKR SAVE T,

YX2UT 4 TTFIAT U ATETEND SNMP —E Z(T1E, 2 ODOBRRHENH Y F9,

o BHIXTFT—ay (FTILSNMP 7547 2 8) 283EE LI- SNMP ERIZISE 2R L E T,

o BHAT—T gl FREEX2VT 4 T T IAT U ADBNEZIET DL IIRESNEE
DMDOTNA R, v T w7 (A2 hEE) EEELET,

X2 UT 4 TTIAT LRI, 3FATDONTy TEYFR—FLET,

s Ty AT Ux—Ib
s VxxUv7
* syslog

b3y TORE
SNMP Trap Configuration Z B < &, RO 7 1 — /)L RRFRINET,

* Standard SNMP Traps : X(ET HEHELT v 7 Z2RIRLET,
— Authentication : FEIEDIEHE N T v T H A X —T M LET,
— ColdStart : =—/L N AX — NOEFEHE N T v T A x—T VI LET,
— LinkUp: Vo7 7y 7 OBERERNT v TE2 A =T ML ET,
— LinkDown : V> 7 XU DOFEHELT v T A X—T M LET,
* Entity MIB Notifications

— FRU Insert : BIAc#mfer = ;b (FRU) 2MEASINTZHED T v T@maE A 2 —7

LIZLET,

— FRU Remove : S5 REL =~ b (FRU) SV ENTHED F T v Tl A F—
T LET,

— Configuration Change : /»— R = 7 EENTONIGED T v @M% A R—7 /1T
LET,

e 1IPSec Traps : IPSec N7 v 7% A X —T VI LET,
— Start : [PSec BB LTZHAED N T v T2 A X —T I LET,
— Stop : IPSec MEILLTEHAED N T v 7 A X—T M LET,

[ oL-10106-02-J
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TFTP Server

e Remote Access Traps : VE— K 7 7R NI v 7% A F—7MIZLET,

— Session threshold exceeded : VE— F 7272 RA&ZBZH & Lty a v Hn, RESH
TWh By a v HOLEWVMEZBIBLIZEED T v 72 A F—T I LET,

* Enable Syslog traps:SNMP EH AT —3 g L ~D syslog A vE—VDOREEA X —T WML E
ﬁ—o

e OK: ZEEEZAFAMMZLT, HATONNFIZREY £,
e Cancel : R AN LT, EHATO/SXRMITREDY £797,
e Help : SR ERTLET,

E—F
WDOEIZ, ZOWELFHATEL2E—RFRERLET,

F7AT 74— E—F t¥aYT4a2TFRE

ILF
L—Fy R Bl AL AVTHR b SRT I

Configuration > Properties > Device Administration > TFTP

TFTP Server XXV T X2 VT4 TT7IA TV AERETHE, TFTP ZRALTCTZ 7 AL P —
NZary74Xal—a VERFETEXET,

TDORENVTIE, V=N T 7 AN EEERLETA, ORIV TEX2 )T 4 TTITAT A
% TFTP % — X CHEHTE 5 L 9 IZRE L THh b, File > Save Running Configuration to TFTP Server
7V LET,

TFTP $—nNEtFa T4 FTSAF7UR

TFTP /X RFC783 33 L TN RFC1350 Rev. 2 THEIN TWA Y U IV I TA TV N/ =T 7 A
WRIET B Fa VT, ZORRANTEXa VT 4 TTIFAT A% TFTP 2 Z4 7> MNTRRET
L, FErar74X¥al—varOat—% TFTP #— IRk TE £3, kT 5I2IE, File
> Save Running Configuration to TFTP Server % 7 V) > 27 3 % 1> Tools > Command Line Interface % 7
Uy 7 LET, ZOHETaAr74F¥al—vary 774 VERy 7T v 7L, ol
TATTIAT VAT mRF— R TEET,

configure net =~ > R CTFTP — 3D P 7 KL RAEZHHE L., titp-server =~ > R TH—1DA
B=T A ALNA | T7ANKBERET DL, ZIWCETar T4 F¥alb—vary Ty AnHE
TRENFT, ZOBEREFATIL T AKX 2 b— 3 VITHEET UL, ASDM T File > Save Running
Configuration % 7 V v 7 3571213 T, copy 2~ RTTFTP H— N2 7 7 A NVEETE F7,

X2 VT TTITAT U ATHR= IS TFTP — N3 1 D721 T, TFTP B — D 7L
sXZ % Configuration > Properties > Administration > TFTP Server C{EE L £ 7, Z I CTHET D
&, CLI @ configure net 33 N copy 2~ RiZarmy (o) TIPT RVAZBETEET, 27
L. BX2 VT4 77747 AL TFTP B — "OEFICNE R, T A 2AORAEE 2L = v
T4 K2 lb—a i, DO IIBNICETEINRET,

l ASDMa1—% A/ F
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show tftp-server avw U RT, BEOay 74 Falb—va iZEENTND tftp-server 2 <2 K
LE—BHRRTEXET, notftpserver 2~ KT, $—_"~DT I ERET 4 &—T M LET,

Ja4—IJLF

TFTP /SR VIZIFRD 7 4 — )V KB D £7,

e Enable: BRI AL, a7 4 X2l — a3 l&END TFTP Y —_ORENA 2 —TIVIC
R FET,

e Interface Name : X =2 UF 4 77 I9A T L ADA v Z—T oA ALEZEIRLET, ZDOA v
H—"T x4 ACTTFIP 4 —"ORTEEHHL E T,

e 1IP Address : TFTP ' — "D IP 7 KL AZ AN LFET,

e Path: TFTP 4 — RO ZAEF AN L LT, EHEHICAT v 2 () 20T, RBICT A NLE
HELET, ZTICE Ty T4 Falb—ra rREZIAENET,

TFTP $—/3D /XA D = /titpboot/security appliance/config3

~
GE) HNAROEHEIEFMLT AT v a () 2T ET

HHAtER

TETP DM HOWTIL, HEHT A Y 7 =27 N—=a DX a2 VT 0 77547 o ZA0HET
v =T NVESZHL TN,

E—F

ORI, ZOHEEZFHTE2E—NERLET,

T7A4F724—)L E—F tXxa)F4 aVTXRFb
TILF
L—FvFK =B 2% AVTXAREb RT A

Configuration > Properties > Device Administration > User Accounts

User Accounts /S /L C, B—h)b 22— F—HRXR—2AFFEHCTEET, n—h)l a2a—% 5F—X
R—2%, ROMETHEHINET,

o I—HTLDASDM T 7 & A

FIHN NTIE, ZHOZ—PFLZ LA F—T I NRAT— REEELTASDM e /A o TXx
F7 ([Password] &), 7272 L, (FH—VLEZHEHALRNT) vl VHEHiE T2 —H4
LRXAT—FREANTEHE, ASDMiZu—H )L 5T —EZ_R—2%F v 7 LTHRELET,

~

GE) a—h ) F—RRXN—2A BT 5 HTTP 3RiF2 R ETX £92 ([Authentication ¥ 7| %
SR . ZOMEIZT 7 4L FTHEIZA X —7 L T9, RADIUS F7-1% TACACS+ — %
AR AT 25803, HTTP RS2 EL £,

o oV —/LEEE ([ Authentication & 7] #Z&MH),

[ oL-10106-02-J
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e Telnet 33 OV SSH #%GE (I Authentication # 7| #5M),
* enable =~ FFHFE ([Authentication # 7| ZZ&[),

CLIT 7 B ADHDHETT, ASDM 1 7 A NIFHEL A,
e -~y RERH (TAuthorization # 7| #%MR),

O—HN TR T a~vy FRBAl A X —TMITDHE, ¥X2 VT4 777
AT VAT —WEHEL L E2RB LT, Poavy RBMEHTEX AR LET, a~vo N
BAINT 4 B—T VDA, BEEHEL VIR EINEYA, T 74NV FTiE, 2w RO
BREL LT 0 £ 15 D E B LM >TWET, ASDM 1213 A R —T/LIC Té“éfiﬁff*%l/
SABRHLNPUDERINTWET, IBETEH LU, 15 (BE), 5 (FAE EA),

(BEHREH) O3FE T, HONUOTEHESNIZ LV Z2EAT 5121, 3@*”@0)4%%1/“/1/

DNFTNNZ2—FERELET,

GE) CLI~OT7 7 v AMEEZRGTE 52—V 2 EXEC £ — FIZANRWE S I2T 512, *+

Da—HFrua—n F—2_X=ZA BT 58I a~r Rz 1 31—

TN D WaEIN

HOET, awr RERAETbARVE, 2—F ik, LR 2L E (275%“7%»%)
DOE. CLI THYDARAZAT— RE2FEH L TEEE—F (BXOFXToa<vr R) |

IR ATEET, HDHWIEL, 2 Y —/L T 7 ¥ Z|T RADIUS itiTACACSnNE%{iJﬂ
LT, 2—% PN login 2~ REFHTERVWEIICTHI L, X Tor—/L =2—HF
ELAULIIZBELT, VAT A AL FX—T N RAU— REHER L CHEE— RIZT 7 &4

TEHa2—VZflifldsZ b TEET,

o Ry hNTU—T T & A
e VPNZI A7 Nidi

Xy MU= 77 RAGEAZIE, m—AN T —F_X—=RIMEHTEEEA,

YNAFALTRAR BT=FORG, VAT AFETAN—A TR ZHRE

L. login 2~ %

EALTCLI &It s A o T&Ed, 7P L, VAT LAE[TAN—ZATiHIn— )L F— 2 ~_—

AT D aaa a2~ FIIRETE FH A,

GE)  VPNHEREIX, vV TFEF— RTHR—FENTWEEA,

(Password CT72<) ZOD/NFILTA F—T )b NAT — REFRET DML, =—4 enable 15 DX
AT — REEHELET, =—HP4 enable 15 TR ZONRFVCERENET, ZHNBRT 741k
D2—HLHTT, ASDM DV AT L a7 4 X2 b—a T, TOFERTHRA F—T7 1 X
AT — RERETHHETT, CLI THOA F—T L LL R2AT — REHRIET 5L (enable

password 10 72 &) . Z D —H¥ 4L enable 10 D X 512720 7,

J4—ILE
e UserName: Z ZIZRTNRIA—F AT 22—V LAE2ECELET,

. Privilege (Level) : = —FICRET HRHEL ~NVEZIEELET, FRHEL VT, m—L av
AR SN ET, .Jqéfrm ZoOWTIL, TAuthorization # 7] &L T 72X,

* VPN Group Policy : == —W|Zi# 32 VPN /L —7 R o —£ZEEELET, vLFE—FK

TIIEATE A,

e VPN Group Lock : =2 —W|ZHATHI/N—7 vy sy R =N, ThEHEELET,

< NVFE— FCIIEHTEEEA,
e Add : Add User Account ¥ 4 7 2 VR v 7 AR LET,
e Edit : Edit User Account ¥ f 72 7Ry 7 ZA2F£RLET,

l ASDMa1—% A/ F
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o Delete : JBIRL72ATZT — 7 ANBHIBRLES, MEEINT, PVELLTEEEA,

E—F
WDFI, ZOWEEHHTE5ET—FE2RLET,

T7A4F724—)L E—F tXa)Fq4 aVTXRFb

ILF
=Ty FK ik 2% aAVFER b AT LA

Add/Edit User Account > Identity % 7'

Configuration > Properties > Device Administration > User Accounts > Add/Edit User Account >
Identity % 7

ZDFTTHRELERTA—ZTa—F 7ho o b2 L, BMERFEERCTEES, £BF
X, OK #27 V v 742 & User Accounts 7 — 7 MZ = bl RrENET,

24—ILF
e Username : 7V hOa—VFLEHELET,

e Password : 2— VD —FEDONRATU—REHFELET, AT — NI 4 X7 RICTH0ERH
DEF, £/, K32 XLFTT, NATY—RIL, KXFEMXFEXEBLET, 74— K
Wi, TAZ Y AN ERENET,

~
G X2 VT REORD, SAT—FESXFULCT I LB LET,

e Confirm Password : fER D72 —H NRAU—REFBASNLET, 74—V RIZiE, TAHX Y
AT mEREINET,

* Privilege Level : 27— /)L 2~ REEA[ Ca—FIZHHT DR L~V AR L E T, 0 (FIK)
~15 () OFPHOMEAHEELET, FEMIZOVWTIE, TAuathorization ¥ 7] #Z ML T<
TEEWN,

E—F

WORIZ, ZOWREEZHEHTELE—REZRLET,

774724 —I)IL E—F tXaT4 aVTFXb

RILF
> AVTHFREb

4

=Ty FK iR

[ oL-10106-02-J
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Add/Edit User Account > VPN Policy & 7

Configuration > Properties > Device Administration > User Accounts > Add/Edit User Account > VPN
Policy % 7

ZOXTTHRELIE VPN R Y v—% a2 —WIZ@HA LE T, Inherit F= v 7Ry 7 AZRINT 5D L
ST AREDHEE I NV—T R o —hbRETEET,

TJ4—ILF
e Group Policy : FIFI CZ 27V —7 RV o —%—ERRLET,

* Tunneling Protocols : = —FRHEHTE L b 7'm havzHELET, £/, 71—
R —DF —ZEMETHNE I NHIFE L ET, %% Tunneling Protocols O F = > 7
Ry 7 A%A AL, 2—FREHTESD VPN hrxb 7'a a2 RIRLET, 22—,
BRSA TS 70 FalosrzfATEEd, BREIRO EBY T,

IPSec :IPtX=VUT7 4 Fubal, ibtxa727 v harThsd &I TUVD IPSec 1.
VPN F U RNVDERBTEERT —F%T 7 F ¥ 2t LE 9, IPSec (X, LAN ] (7Y —E7)
Wi, 7947 M LAN OO 7 ST £,

WebVPN : SSL/TLS #F|H 75 VPN, Web 7 7 U HEHEHL T, VPN 2> &> b L —F~D
TXaTRIVE—FTI7EBA PURAVEMIYL, V7 N2 T 03— R0 2T DI T47T
VREMSEE LETA, WebVPN AT 2 L, HTTPS A v ¥ —% > h A FEFRIHTEZ 3
FEAETRTOarEa—2nb, £FED Web A ~, Web X7 7Y 7r—3 3 > NT/AD
77 ANIHE (Web xfi7) . BFA—N, BEORZOMD TCP X—RA 77V r— g iy,
MEIAWRZEY YV — R HEICT 7B ATE X520 F7,

L2TP over IPSec : \\< OO — 172 PC B L OPENA NV PC DARLV—F 4 F VAT AT
I ND VPN T4 T b EFERALTHWAE I E—F 2—FR, XT Y v I P Xy hT—7
ENLTCEXa2 VT4 TTITATUVABLIORT TAR— ¥Ry N =T ~DEBX 2T 7
B CE D Lo LET,

A Y
GE) 7o barizBERLAPoTEHE. =7 — Avke—URFranEd,

o Filter : i T 274 NV FERELET, 7o, =7 R —DF = F kT 5089
MBRELET, 7AVZIE, ExXa2 VT4 7T IAT AR L TERLEZ R 7
SNTT =8 Ny e, REILT FUA 5867 RLA 7r banp EORREIC L - T,
AT L MERT O MERET DL — LV THRSNET, 74V ZBLONL— LV EZRET DI
I%. Configuration > VPN > VPN General > Group Policy /S /L& B L T Z X0,

e Manage : ACL Manager X%V & F R LET, 77&8A arba— JA K (ACL) BIUYE
R7 78R ar hr— U AL (ACE) OB, MR, BN TEET,

e Tunnel Group Lock : h> )V J—7 vy 7 NHHGE, TNEHREATLE0E I, £t
BRLIZ bV IV —T a2l TNEIDERELET, FFEOR v 7 Z3IRT
HE . a—HFDVE—KNTI7RAIZOIN—TEFICHIBENET, b Zr—F oy
JIX. VPN T4 TV P TRESNTZITN—TRN, ZO2—FREV Lo TND T NA—T
ERILNEIDETF v 7528285 T, 2—VEHIRLET, AL TRVGA, EF=
VFr 4 TTIAT AL, =R TE WIS LET, Inherit F= v 7R v 7 AN A
7 DHBE. T 7 /v MEE --None-- T,

e Store Password on Client System : Z DR TE%E Z N —TNOHMKTIEINE D NERELET,
Inherit F = v 7 Ry 7 A% 4729 5D &, Yes/No DA T a s REUBANIRY E3, Yes
BEERTDHE, al Ay RRAU—RRIZ T4 TV b VAT ARESNET (X2 VT4
DK FTHRNOHDLAT a2 TT) , No (T 740V K) 28RT D E, 2—ViEEHRTL
WICANAT— RADNRRDENET, KBOEX 2V T 1 MR T D101, RATU— RORTGE
WEFFRI LW L2 BEID LET, VPN 3002 DA, Z0/3T7 A —H Fxfii8 — Ko =7
7 T4 7 v FRBRERE R — P RERETIEEME L £/ A,

ASDM 21— 4/ K
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e Connection Settings : #EHiiX E/NT A — X H#HEE L E T,

— Access Hours : Inherit 7= v 7R v 7 ANA 7 OEE, BEOT 7 2 AREMRY O —2dH
U, ZO4FIZRINL CZO2—WIZHEHTE £, £/ FHOT 7 & ARERAR Y v—
EVERT DI EHTEET, 774/ MM Inherit T, F72, Inherit F= v 7Ry 7 ZAH
7 DA DT 7 4 /v MiX --Unrestricted-- T,

— New : Add Time Range ¥ 4 7T R 7R v 7 AN, 727 B ARMOFHE Y ME2HEETE
iﬁ—o
— Simultaneous Logins : Inherit = > 7 R v 7 ANA T DA, KR 74 0 TE HHK

A—YPREEELET, 7740 MEIZ3 TT, B/MEIZO0 T, ZOHERT A RN T 4
=T A=Y T I A ERIELE T,

A

(F)

BRRMEZBREL THIRLZ2WES, 2 ORISR/ S, EF=2 0T 0 &N
T A=~ ADKT R ENRHY £,

— Maximum Connect Time : Inherit F = v 7 R v 7 ANRA 7 OBE . 22— O KR
(GrHfAD) Z#HRELET, ZICTHRELZFEESRBTLIE, VAT AIEREK T LE
T, BAERFRIL 1 5T, REFMIL 2147483647 43 (4000 4E4B) T, HEFERE A EEHIIR
(23 5i21E, Unlimited F= v 7R v 7 Z&RIRLET (F7 440 1),

— Idle Timeout : Inherit = v 73R v 7 ANF T DFE, 22—V DT A NV XA LT 7 FE
M (HAD) ZHELET, oM, 2—VERIGRET 77 4 E7 0 BN olzifa,
VAT NI AR T UET, RERFFIIE 1 4T EREIX 10080 45T, Z OfEIX
WebVPN = —HICITEH SN E A,

* Dedicated IP Address (Optional)

— TPAddress Ry 7 A : HHIPT FLAZHELET (A7 ar),

— SubnetMask U 2+ : HHIPT FLADOY TRy b w27 ZHELET,
Group Lock = v 7/ Ry 7 A% RIRNTLH L, 2—FDVE—F 77 EBRATZOIV—TTEFITH]
RENFET, =T avliE, VPN 7 T4 T2 N TRESNTZIN—TR, TO2—FNEY
BTOHNTNWDEITN—TLREILNEIDET v/ T5EICL-T, 2—VFEHIBLET, RL
T72Wi4E . VPN Concentrator [, — VR T2k oL E9,

COF =y IRy I ARFT7OE (F74/4 ) 2—FRED 4 THEATND 7 L—7 LR

M =Y EARIEL 7,

E—F

ROFIZ, ZOHEZHEHTEL2E— 2R LET,

2747 2+—)L E—F

tXaTF4 3a2TFXFb

LT
=7y K Bl SUgL aAVTFEXRb SRT L

[ oL-10106-02-J
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Add/Edit User Account > WebVPN %4 J

Configuration > Properties > Device Administration > User Accounts > Add/Edit User Account >
WebVPN % 7

Add User Account /3% /L% 721X Edit User Account /X% /LD WebVPN # 721X 6 DO X THRHV |
WebVPN D=2 —H 7 F B a— hERETEET,

24—=IF

e Inherit : XIS T DREN, TORIH K P RRIBE TR, T 74NV K JV—T K v—
MNOHEEEETIZ L ERLET,

o Functions : WebVPN =t — ¥ M T& HHREZ R E L E7,

— Enable URL entry : 5—A~X—Z URL ANJAR Yy 7 AZEBEBLET, A x—7WIZT5H
& 2—PIXTURL AR v 7 A2 Web 7 RL A& AL, WebVPN ZfEfi LTz b0
Web A MZT 7 EATEET,

WebVPN ZfEH L TH, T _XTOHA FEDBEREXR2TICREIDITTIEH Y £ A,
WebVPN IZ, B¥Xy bV —27 LDV E—=FPCRUV—I AT —VareexallT 4 T
TIAT LV AEDBOT —REGEEOYX 2 )T 4 ZRFET D HDOTT, LIz -T, —
PN HTTPS LA D Web U V) — A (f X —F v b ESRPNE Ay NU—7 LiZhH D H0)
T 72T 588, REOEX2 )T 4 TFIAT U ANG BD Web —XF TD
BEITZEXF2T7TIEHY ¥ A

WebVPN #:#i Cld, t X2 VT 4 77T IAT VAT R 22— D Web 7T U & X —
7w h Web h— LD D7 ax b UTH#EEEL £7, WebVPN = —¥ 73 SSL %fiz Web
P—NIZEH T2, X2 VT 4 T IAT AT X a7 Bk & fer L. SSLiE
HELZRIELET, =0 N 2—FO7 7 U EERENT SSLAEAEEZZE Lz,
ZOREEERGET S Z LIXTE EH A, BIIED WebVPN O FEEETIL, AR EIN
TREAEAZ LT 204 P EOBERITTF I ESNERA, £, EX2V T4 77547
VAIEHETE D CAFFHEORIELEITLEY A, TDZH, WebVPN =—H%, SSL
RS Web h— N L IBET R0, REESNHEAEEZ DI T EHA,

WebVPN = —HF DA U H—F v b 77 A%HRI 521, Enable URL Entry 7 4 —/V K
PIEPER L E T, RIS X o T, WebVPN =—H}%, WebVPN #1 Web ¥— 7
VINTERLL D E T,

— Enable file server access : HTTPS %41 L7~ Windows 7 7 { /L 7 7 & A (SMB/CIFS 7 7 A
NDH) A RX—=TMILET, ZORy 7 AZERNTLHE, 2—F IRy NUV—7 LD
Windows 7 7 A /WIZT 7 EATEDH L HIZ72 0 £, WebVPN D7 7 A LALFHIZ Z Do)
FA=ZPE T A 2 —T M LT84, Servers and URLs 7 /V—7 R v 7 A THRE I NT-
P—NZDHT 7 ATEET, 22— R —RNCEET 7 EA LY, Xy NU—7 1
DY —NE2HZRTE 5 L HITT ST, Enable file server entry 35 & U" Enable file server
browsing /X7 A —&Z OFAEZ L T30,

TrANDE T a— R e, HIBR, ARIERE, BEINTEET, 77 ALETHNH
DOBMLTEET,

#WH 72 Windows —/" D2 —H 77 B RAE(TH 12010, HELRETIHILERNH Y F
T, Xy NT—ZFIZ L > T, 77 AT 7B AT HENI, 2—FOFEGEDN LI
e ET,

TrANTIERA, =] AL TR, BLIOBREITHITIL, WINS —F
i~ AX— 77 0% (B, EX2VT7 4 TFIATVALE Ry VT—2 Fiz
IXZDFRy U= DLBERRER R v MU —ZFHE) ZRETILERD Y $9,
WINS = R_REF~vAF— T T UFE, ¥F2 V74 TTIAT ARy hU—7
LtV =20 A FEEMELET, ROVIZDNS B —R"E2EHTHZ LITTEEEA,

(GF) H#A 73>y 7 DNS ZRIFHIMHER LTV 54A . Active Native Directory Bg5i T7 7 A /L
TR RFYAR— FENEE A, WINS B—_ZRKHIEH L T EEEICR— &
nEJ,

ASDM 21— 4/ K
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— Enable file server entry : ;R—% /)L X—\Z7 7 A )b Y— "D ARy 7 AZEELET,
Tr7AN Y =T IR X—TNMITDHLERHY 7,

IDF v IRy I AEERT S L, 2—P1X Windows 7 7 A VDR AL HEBEAT]T
EHEOCRVET, ZrAr0F v ra— R, e, HIBR, ARIZEE, BEINTEE
Ty T7ANETHFAXDOEMLTEET, 22 TH, #Y7 Windows — 3 ~D—
YT I BAEITHIEOIL, ELRETILERHV ET, *y NU—JEHIIL-T
(= 77/1’1141777?7\?“&1” o, 22—V OBFIENMLEI R £,

— Enable file server browsing : Windows v NV —27 b RAAL Y | D=7 T —TF $—
N, KFEEBZRTEET, 77 ANV PN T I EREARZ—T VT HLERS D 7,
OF 2w IRy 7 ARBNTHE, 2—FRRKAL VBIORTY—27 7 —T %8R L,
ZDRALHNOY—=A"BLOIAZZRTE L L9122 £9, #Y)72 Windows % —
NRAD2—F T I ERAEATI DI, MELRETLHMLERHY £3, xRy NV —7 3
{ﬁFL:J:’)VC&i\ “j‘“*/\ﬂl7’7JZX@“éﬁml\ :L%qji@nunftﬁ‘zg fot @ i?‘o

— Enable port forwarding : WebVPN &R — M & HT 5 &, 7 v—7HNO Y £— b =2 —F
MEEAOEE TCP/IP R— FTBET 27 AT v MY =TTV =2 a7 7k A
TELE2R0ES, VE—bF =L, m—=WAVPCICA VA =N ENTT TAT
YETTVr—varEHEHLC.EDOT TN r—va v EYR— T 5 E— b =
WICERIZT 7 BATEET, A2 TlX, Windows Terminal Services, Telnet, Secure FTP
(FTP over SSH) . Perforce, Outlook Express, 3 & U8 Lotus Notes {22V T7 A F L TWET,
ZOMD TCP R—=ADT 7'V r—va v O—HbHIET 2L E2 b ETR, Y AT
TAFLTWER A,

~

GE)  A— MEXIZ. —FD SSL/TLS N— 3 » TIIBERE L 8 A,

IDF v IRy T ABRRTLE, o—IABIORVE—hK VAT LD TCP A— %
~ o TTARI kT, 2= NI TAT U N =R T T =g Tk
ATEDLLIWTRVET,

GF) TUXNGEHEERZMEHL C2—VEHIAET DA, TCP &A— MEk JAVA 77 L v b
IIHEBE L £ A, JAVAIZ Web 79 U DF—ZA NTICT 7 EBATEERA, FD7-
HIJIAVA X, 77 U R — PRI T A5EAZEZFEH X, 77U r—v 3
VEEBTEERYA, 7TV = a TV BATED L DICT B5E1E. WebVPN
2—YORFECT VX NFEAELZHEHA L2V TEE0n,

— Enable Outlook/Exchange proxy : Outlook/Exchange &1 A —/L 7B X% A4 x—7 ML
E3 e

— Apply Web-type ACL : EFHR S TS WebVPN DT 7R v ha— L YR &I DT
N—T7Oa—WFZEALET,

— Enable HTTP Proxy : 7 74 7> b~O HTTP 7 7L v s 70X Dlnkz A F— 7 /LIC
LFET, 7axiL, Java, ActiveX, Flash 72 &, @~ 7 ) o 7 & ihF 2 Hdific st
LTHEHTY, ¥Xa2 VT4 TFI9AT U RBHLERNRG, =0 7)o T a4 AL
T, BETeX R, Y7o e UREE HEIMIZBEIEL, X To HTTP
BIOHTTPS ZRAZFT LW m X BREIZY ¥ L2 h LET, HTML, CSS, JavaScript,
VBScript, ActiveX, Java 72 &, HEEFTXTOIVIA T ML R T /no—%H KR —
FLET, AR —FEND T T 7YX Microsoft Internet Explorer 7215 T3,

Content Filtering : Web ¥4 F® 9 L Java 7213 Active X ZEHT 2855, A7 U7 M &EH
THHT, BBEERTT IS, BLOY v X —2BET2HsE2 T 1 /7?71 ITHIBR LE T,
T ANVETHE, ZRODNRTA—=ZFHEHR>TNT, T4 FZ ) T3 TbhEE A,

— Filter Java/ActiveX : HTML %> 5 <applet>, <embed>, <object> % 7 ZHIFr L £3°,
— Filter scripts : HTML 75 <script> &% 7 ZHIBR L £ 7,

[ oL-10106-02-J
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—  Filter images : HTML 75 <img> % 7 Z ¥l L £, BEE2HIBRT5 L. Web 2— DR
BARKEICEERLSET,

— Filter cookies from images : B CEUME SN 527 v X —ZHIFRL T, LEZITZ vXx—%
AL CHlE 2B 5720, ZNUCE > Ta—F D7 ITA N\ =S E T,

Homepage : " —LX—U THHT L DORHIUTHEL 7,

— Specify URL : %D 7 4 —/L RIZ7 0 ha v ERETHHAICHRELET, http F721E
https &, B—L_X—VIEHT D Web X—T D URL ZHETEE T,

— Protocol : IR— L=V OEHET T b3l LT, http £72(X https ZFEE L T,

— i/t Web =YD URL & — L=V L LTIRELET,

— Usenone : R—AX—URHEEINEHA,

Port Forwarding : 38— MRENRT A—F ZHRELET,

— Port Forwarding List : " — MEEY X N&2T 7 4V N Z—7 KU —n bk T 50,
UAIDPHERT 200, HLOWAR— MREEY 2 NEAERT 5202 ELET,

— New : FBiAR— MREY A FZBMTEDLH LW UNFKRENET, Add/Edit  Port
Forwarding List /S /L DFHAZ SR L TS E X0,

— Applet Name : 7 7Ly N LA T D, RNy 7 ATHRELZAZERT 202 HEE
LET, TOARIZEELT, =2 F 2=V L TR— M@ LEd, RELE
AT, = R 2= A =T 2 ARy MY 7 ELTERRENET, 2DV 7
Vs FBEJavaT Ly b Uy RUNRHE 22— IR EINTZR— MEkT 7
Vir—2alBDNEREIN, 2677V r—va T 7 BATEET, 774/ 5D
7 7L N4 1T Application Access T,

Other : " — NEB L URL Y A b, Web # A 7D ACLID % E L E7,

— Servers and URL Lists : — XB X OVURL @YU A F & k& T 20, BEfEO U X b &2 @R
B, FHLWY R RNEAERT B EEELET,

— New : FHIA— MEEY X MEBEMTELZH LWSEARTRRINET,
—  Web-Type ACLID : i[9 % Web %A 7 ACL O3 %2 HEL £,

SSLVPNClient # 7 : X% 205 4 7794 T A %K ELT.SSLVPN 7 74 7> b (SVC)
ZUE—F arba—FIFvrue—RTxET,
SVCIX. #*y hT—2EHENIPSecc VPN 7 A T b2V E— b 2 Ea—XIIAf VA F—
AL, BRELRLSTH, UE—F 2—¥ N IPSec VPN ZFHTE 5L 51292 VPN bV
VIUEHWTT, SVCIE, TCICYE—F 2y a—FIZHhASSLEE e, EXaUTF 4 T
TTA4 T AD WebVPN 1 7' A B I ORRGEEZ A L £,
SVC vy a &t 22, VeE—ha2—F3xaVT 4 777472 AD WebVPN
AVE—Tx2A ADIPT RLAETIUWIZANLET, 7730 IEEDA U F—T = A AT
i LT WebVPN DR VA VHEHZ R RLET, =B/ f U ERFEERT L, B2V
TU TTITAT VAN O2—H % SVC BB Ra—P L LTHINLESRA, X207«
TTIAT VATV E—F a2 Ea—HIISVCEFXYV e—RLET, X2V T4 775
AT VAN D= % SVCRA T ary TCHEATEA2—FL L THBILIEGE. %=
T4 TTITAT L AEISVC DA VA=V EAXy 5 7 ba—VEEICFERLT,
VE—h 2 BEa—XIZSVCEFAYBE—RLET,
Horoa— R, SVCIFHOA VA M= BIOREEZITV., HER/KT Lo XL, BRE
WIZINCTC) VE—F arvEa—X K0, AT A A =L LET,
X2V T4 TTIAT VAR, BBV FE—h ab Pa—20FR—F 47 VAT A
FIZ, BEO—EDSVCAA—VhF vy o AFVICHEEEAZENTEES, 22—
DR LELO L LT &, BX2 VT4 TTI3AT VR, A A=V EFRL—T 4T v
AT EN—HTHET, INHDA A—VO—HErEE L Xy ra—RKLET, ~KTbHL,
SVC D&z 2y ra—RLEd, VE—F I Ea—FDFX—F 47 VAT L EK
H T HAREMERE A A —URRINCHT T or— KI5 L 518 SVC A A — V&I~
2T, ¥ty N7 v TE R RN TEET,
— Inherit : XIS T DREN., ZO®%IH S PARPRIBETIE R, T 744V 8 ZA—7 &K
U BEERETAZEE R LET,

ASDM 31— JA F
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Keep Installer on Client System : 7K#t/%)72 SVC A > A h—/L& A F—T MIZ L, SVC DH
B7 oA A= EREE T 4 B =TT LE T, %D SVC #5 TiX, SVC 1Y E—
b ara—ZIlAf A =V ENTCEETOREIC/R D720, UE—F =% D SVC ~
DGR DN M S E T,

Keepalive Messages: *— "7 74 7 A v — OMEE % 15 ~ 600 F O CHHE L E T,
TI7HNITE, =TT I9A47 AvE—VIFET 4 =TV TT,

Taxy, IrAT VA=, RIIENAT T3 ADEEREDT A VR 2 IR 556
TH, ZNHDT N, AEFRT D SVCHEMBAWCEEIIRL LI, ¥—TTF747
AvE—VOBEAPFETEET, £, HEZWET L L. UE— F 22— Microsoft
Outlook <° Microsoft Internet Explorer 72 D Y /r v h_X—A TSV r—va v &7 77 47
ICEATLTWRWEEIT, DIl LTl T 2 Z L3 R0 £7,

Compression : SVC it COEMiZ A F—T M LET, 774/ TR, EMEEA F—
T o TWET,

SVC [Effi&AT 9 &, BEEIND /Ty OV A RO T 5720, X2 VT4 777
AT AL SVCRIO@EENT 4+ —~ AW ELE T,

Rekey Negotiation Settings 7 /L —7 Ry 7 A : X2 VT 4 77747 A& SVC
AR T D LT TR PreFRrAv e — g LT EitEx =2 U T4
ik LET,

Renegotiation Interval |, &> ¥ 3 VAN OO FAKE CORE (HAD) %1~
10080 (1 #fH]) OHFPHTHEL £

Renegotiation Method /X, SVC #EDFARKDERIT SVC FH LW N RV EFESLT DN E
IMERELE T, none ZRINT D L SVCHEOFAMIT 4 £—7 0270 £9, ssl
BRI D L. SVCHROFIEROBRIC, SSLOFRIvT—v a URNETEINET,
Dead Peer Detection : Dead Peer Detection (DPD) (%, E'7 2GR L TV RWZOITR L
et Xa )74 7779470 A (U= U=A) £720F SVC TRIRICHRINTE S
oL Ed,

Gateway Side Detection (X, EX=2 V7 4 7779472 (F— U= A) 12L& 2% DPD 3%
T4 3=z, ¥X=2 VT4 7774 T 2 A0 DPD % E473 HHEE % 30 ~ 3600
(W) OFPHCRHRELET, disable ZERTDHE, ¥X2 VT 4 TTI7A4T AL
X% DPD OEITNT 4 B—T MR £,

Client Side Detection (%X, SVC (7 A4 7> 1) 2k % DPD DEFTEA X —T ML,
SVC 78 DPD % 5479 D BHE % 30 ~ 3600 7> (1 Kff]) OHEIFTHRE LE T, disable %%
RI2 L, SVCIZX D DPD ODEITNT 4 =T MR 0ET,

EF—F
WDOFRIZ, ZOMREEHFHCTE2T—FE2RLET,
774724 —I)IL E—F tXalT4 aVTFXb
TILF
L—Fv K iR 2N aAVTFR B ORT LA
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W Auto Update

Auto Update

Configuration > Properties > Auto Update

Auto Update XA > CEXa VT 4 TTIAT L ADEHY) E—F $—NEHRETIHE, VE—F
H— 3T Auto Update {4 % ¥R — F T& £9, Auto Update ZFIHTH L, EX=2UT 1 7774
TURZAY T 4 X2 b—va OEREHEA LY NGNS 7 b 2T Ty T — b
EEALEY TEET,

Auto Update 13, X2 VT 4 7T IA TV AOBEHENER T 5 S I ERMEE MR TE HE
Fl7pBERE T,

e HAAFIvI TRy U TBIONAT BT MR EfR L £,

o BEART IV varmoar7 a4 Xal—va UEREZHEFEIIKMRLE T,

s BEHEOEWEATY 7 MU T EEHLET,

o HCEREOBLFAEZISHL, MWVIEEERH Y £,

o FI—TUAF =T A AT, EOOLTHWHFEABENHY £,

e VbR TuRNS L —BEOEX2VT 4 V) a—Ta VIZEGIIIETEET,

e EWEHEMELEBELEXa T ¢ BHERESY, SESERRBICEVWAIIFR—MLET,

Auto Update DH#IE

Auto Update fHiEIX, Wi, FXEEOEHR»S, VE—NEBRT 7V r—va i exa
UVF 4 T XI5 T ADA T 4 Fal— a0V T NI 2T A A=A a— LT
V., BEARMZEAMEZFZET LEZV T 258ICMERA VT ITANTIF ¥ TT,

Auto Update f1ARIZHE S Z & T, Auto Update 4 — XX =2 VT 4 77X IA4 TR a7 4F =
L—ya UiERET vy va Lo, ERERE L THRERS LY TEET, /2, EF%=2Y
F 4 FTTAT Y AND Auto Update H— S~EBIICH— Y v 7 S, BHO2L T 4 FaL—
vartERELESZ L TEET, 72, Auto Update V— NIWOTHLEX =2V T 4 TFI7A47
VARILavwy REFEEL, LEBICAR -V 7 EREEESEDH T & H TEET, Auto Update H—
NeteXall T4 TTIAT LV ADBRETIE, BESRER—DLCLI a2y 7 4 Falb—ray
ETRCOEX2 VT4 TTIA TV RACRET HLERDY £7,

tX2 VT4 T TA4T 2 AD Auto Update HREIL. v A2 DX =2 U 7 o WA EJFHTE £33,
=R N_N—=F 4B TEX2 T T 7/1’7//??&@@#5_&%(%&@“0

WRLEH

s X2 UT 4 TTIAT LV ADALT 4 F 2 Lb—3 3 7 Auto Update THEH ST H ., ASDM
WZIdEAM S U EH A, Refresh F 7213 File > Refresh ASDM with the Running Configuration on
the Device 27 V v 7 LC, i a7 4 Fab—va VERGTOLERDHY £F, Fiz,
ASDM Ta v 7 4 o b—a AIMATERITRDNVET,

e Auto Update — "L Di@E7' 1 ha/bd L CHITPS 28R4 2L, EX2 VT 4 7T I7A47
VAFSSLEFHALET, TOHE, EX=2 VT 4 77T 47T A DES £721% 3DES O T

AV ANLETT,
J14—=ILF
Auto Update 2 > |Z1Z, Auto Update Servers 7 — 7 /L DAthIZ Timeout =V 7 & Polling = U 7 3% ¥
\i‘é—o

Auto Update Servers 7— 7 /L"C, Auto Update H—/MZT TIZFRE SALTNDHNRT A — X AR TX
FT, BXa2VT 4 TTIAT VAL, T—TNVO—F LZH DLV —"EEYIIR—Y v/ LE
T, T NDOY—RFRMNEEZEET HIT1E,. Move Up F721d Move Down RH¥ %7 U w7 L
%7, Auto Update Servers 7 — 7 /WIZITIRD B 7 2036 D £,

ASDM 21— 4/ K
m. 0L-10106-02-J |




| £8E T4 X FTONRTLORE

Auto Update

e Server : Auto Update Y — SOLFTE 21T IP 7 KL A4,
e User Name : Auto Update —/ D7 7 & AHFIZHH S 52— 4,
 Interface : Auto Update Y — S~DIEREFRFICHER IND A V F—T = A A,

* Verify Certificate : Auto Update — "R L7ZGEAE%L, X2 U7 4 77747 2 A THA
i (CA) ON— FEAFELERAETOEINEINZIBELET, £D%HE. Auto Update — N &
X2 VT4 TTI7A4T7 AL FL CAZBERTLRLENRDHY £,

Auto Update Server 7— 7 /L DITOWNTInE X 7/ U v 7§ 5 &, Edit Auto Update Server 4 A
7 7R E, Auto Update H— DN F A —F BT TCEET, BEITT =T M HICETR
SNETN, Apply 227 UV w7 Lgnk, ar7sFalb—ia ViRkfFSnEt A,
Timeout =Y 7T, X =2V T 4 77T747 AN Auto Update — 3D X A LT U bk &REOREH]
HFERETEET, Timeout TV TITITRD T 4 —/L KRH Y £,
* Enable Timeout Period : €% = U7 4 777 A 7 2 A%, Auto Update — 0 BIREEZIF L
ol FALT T NLET,
e Timeout Period (Minutes) : Auto Update — N BIREN RN TG5O X2 VT 4 77 T4
TYADLA LT U MR (DHAD) ZERELET,
Polling = U 7 C, X a2 VT 4 77747 A5 Auto Update —DIEHRZFR—Y 7T 5
FEZRETEET, Polling =V TIITRD 7 4 —/L ERH Y £1°,
* Polling Period (minutes) : E¥ = U7 4 777 A 7 > AH 5 Auto Update H—/NZH LUWMEHR %
K=V 7425 L ZO/FELEM (M,
 Poll on Specified Days : R— Y > VDAV a—VERELET,

*  Set Polling Schedule : Set Polling Schedule % 7 1 778 » 7 2733/~ 4L, Auto Update % AN— 1V
YT HHERAERETEET,

* Retry Period (minutes) : H—/"XOR— U » TIZRIR LGS, X2 VT 40 TTITA4A TV AND
Auto Update ¥ —/MZH LWMEREZ R — U > 7325 F TORLRME (GrHALD,

e RetryCount: ¥X¥= VU7 1 777 A7 AN 5 Auto Update h— NZH LWMEHRZR—V 7
T 5 & & Om/AITEIL,

E—F

KOFIZ, ZOWEEZHBHATE LT F2RLET,

IF7AT7 74— E—F X274 aVTFRE
RILF
L—TvF Eif bl IVTHRb VAT LA

Set Polling Schedule

Configuration > Properties > Auto Update > Set Polling Schedule
Set Polling Schedule #4710 7Ry 7 AT, ¥x2 VT4 77747 A5 Auto Update H-—X
ER=V T HREDOH LRFZIEZRE LET,

J4—ILE
Set Polling Schedule %A 7 1 7R v 7 ZIZIFXRD 7 4 —V RBH Y 7,

Days of the Week : X =2 U T ¢ 7754 7 AN5 Auto Update Vr— "2 KR—V 7T 5HEHD
Fxv IRy 7 AeBIRLET,

[ oL-10106-02-J
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Daily Update Window 7 /v —7"C, BX =2 U7 4 77547 2 A5 Auto Update — 2R —1 >
T HMAERELET, ROT 4=/ FRHY T,

e Start Time : Auto Update DR —V > ZBtARZIZ A LE 5,

e Enable Randomize: &¥ = V7 4 77 T4 7 2 A5 Auto Update V— 3% 7 L & LTEIR LT
REANC A=Y 7 LET,

E—F
ORI, ZOHEEZFHTE2E—NERLET,

T7A4F70+—IL E—F XalF4 aVTEFRb+
ILF
YT AVTEFRb

=7y K B

\'I

Add/Edit Auto Update Server

Configuration > Properties > Auto Update > Add/Edit Auto Update Server
Edit Auto Update Server & 7 02 7R v 7 AR DT 4 —/V KBH Y £7,

e URL:Auto Update h— "\t Xa V7 4 T I7A4A T ALBETHEICHEHT 5. http 721
https @71 |k =/ & Auto Update $— 3D 32
* Interface : Auto Update —/NICER A XEFTOBRIMEHAT 24 & —T7 =1 X,

e Verify Certificate : £ = U7 ¢ 777 4 7 A% Auto Update H— /73K L 7= FERAZ % 585E R
(CA) D/b— FEEAE &l U CTREE L £9, £D%5E . Auto Update h—NEbtFX =2 U7 ¢ 7
TIAT AL, FU CAZEHTL2LERDHY £,

User = U TIZIZRD T 4 —L KRB £,
e User Name (Optional) : Auto Update V— 3D 7 7 & ARHIMNE /oo —F L E AN LET,
e Password : Auto Update — D2 —H% 2T — K& AHLET,
¢ Confirm Password : Auto Update ¥ —/ 3D —H AT —REHB AN LET,

EF—FK
WDOFRIZ, ZOWREEFEHTEX2E— N2~ LET,

774724 —I)IL E—F tXaT4 aVTFXb

RILF
> AVTHFREb

=Ty FK iR

\"
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Advanced Auto Update Settings

Configuration > Properties > Auto Update > Advanced Auto Update Settings

Za—ILF

* Use Device ID to uniquely identify the ASA : 7 /34 A ID IZ X DFBFEE A RF—T M LET, T
AAIDICEY, ¥X=2VT 4 T7FA47T 2 AN Auto Update — N C—EITHAI TE £,

e DeviceID: T AT A AIDDIATEANLET,
— Hostname : " A F DLRITY,
— Serial Number : 734 AD L) T NLEF T,

— IP Address on interface : IR L72A L X —T =2 AA ADIPT RV A, X274 T4
7 ¥ A% Auto Update — "3 —FIZi&BIT 25 AGICEHR LET,

— MAC Address on interface : IR L7ZA VX —T7 =2 ADMAC T KLV A, BXx=2UT4 7
7T A7 A% Auto Update — B3 —EA#HAT 25 AITHEH L ET,

—  User-defined value : —E O —H ID T,
E—F
WD, ZOWELFHTEX2E—FERLET,

774724 —I)IL E—F tXalT4 aVTFXb
TIF
L—FvFK iR 2N aAVTFR B ORT LA

ASDM 31 —H 1A K
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Client Update

Configuration > Properties > Client Update

Client Update ~X4 > T, Auto Update h—"E L CRELTCEX 2T o4 T T4 7 2 RIZBHHEAS
\F72 Auto Update 7 7 A4 7> hDNNT A —E EFHELET,

Auto Update %—/SDH4, Auto Update 7 74 7 > MIRESINTE X2 VT4 TTI7A4 T R
TTy N7 —LE ASDM DA A—VEIBETEET, A A—TVOY Y ar&FLGH, ER
TLTNARAID, TARAT7IV, IIAT YV EDTNA A XA T ENEFENET,

Auto Update Server & Client Update O#=

Auto Update fHERIZ, FRND, VE—MNEET SV r—vailivex=a740 77947
ADAL T 4 Fal—varRV T N7 A A—VhkF T a— KLz ) | FRN) e B EE
FATLTEV T DGR BEBRA L TTARNTI I F ¥ TT,

Auto Update ¥ —/SOAEERIZHE D Z & T, Auto Update 4 —Nidt X2 VT 4 77 T4 T A2
Ta4Falb—valsFRe Ty va L), BEREFELUERZIG LY TEEd, 72, &
X2 UT 4 TTT7A4T A0 G Auto Update r— S~EHIIZAR—V v 7 &8, &Foar 7 ¢
Xal—raEWaekts &b TEET, £72, Auto Update —NZN0DOTHhEXF 2 VT 4 7
TIAT AL a<wy FEXREL, EELICR—V U J7HEHREZRESEDLZ L L TEET, Auto
Update — &t Xx a2 U7 4 77 I7A4 7 AOBETIE, BEASAELE—H/LCLI a7 4 F =2
L—a a3 _XTCOEXa VT 4 TTIAT UV ACERETDOILENRD Y £77,

Z4—ILF
Client Update <A NZITIRD T 4 —/V KHRH Y £7,
e Enable Client Update : X = U T 4 7774 7 > AL, Auto Update 7 71 7 > MIFKE I N7z
MOEX=2VT 4 TTIATAPEHLTNDA A=V EEHLET,

e Client Images 7 — 7/ : ZXEHFH D Client Update => MU ZF/RLET, ROBTLARHY F
‘j—o

— Device: 7 T7A T2 hDTF A AIDIZHIET DT FA MXFEINEFRRLET,

— DeviceFamily : 7 747 FO7 7 I VA ZFRLET, asa, pix, 7F A FLFHIOWT
ﬂﬁ"’f‘j—o

— DeviceType : 7 7A T b DOXATZER R LET,

— Image Type : £ A—2 XA T ZIEELE T, ASDM A A —T E721E Boot f A—TDW\T
ﬂﬁ\b@—dﬁo

— ImageURL: Y7 b7 =7 a2 R—%> h® URL 2fEE L £7,

— ClientRevision : Y7 U =7 ayR—3k bV EVa rHBEERELET,

Client Images 7 — 7 /VDITOWT W& X 7))V U » 273 % & Edit Client Update Entry 4 1 7

QIRHE, VIAT U M NRTA—FEERCTEET, BRIFT TNV ELICRRINE

T Apply 7 Vw7 Lk, ar7 s Fal—va MR EFESREE A,

* LiveClient Update =V 7 : > RN TEIEEX 2 VT 4 T I7A4 7 AICHERHRIN TN D
AutoUpdate 7 74 7> b, TiZBLICHEHFLET,

— Tunnel Group : lall] #BIRTHE, TXTO M xb JA—7 ETHERH LTS Auto
Update 7 A 7> bETRTHEFHLET, £, PRV ITA—TEBREL T FA4T
NEEHTH L TEET,

— Update Now : 7272 HICHH 2B L £,
N

(3¥) LiveClientUpdate 1Z, X2 VT 4 T ITA TV APNL—T v K E— RIZEREZINTND
GaOHMEHTEET,

ASDM 21— 4/ K
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Client Update W

ROFIZ, ZOWEZHEHTEL2E— 2R LET,

T7ATI24—IL E—F

tX¥aVTF4 aTFXFb

=Ty FK iR

RILF
>IN AVTFRE

\'&

Add/Edit Client Update

Configuration > Properties > Add/Edit Client Update

J4—ILE
Add/Edit Client Update & A 7 02 7R v 7 ZIFK D7 4 —/V KRH Y £7°,

e Device Identification 27 /L — >

Device ID : 7 74 7 > b Oz —EOXTIITIT O WEIL R > TWDHHAEIT, A F—7
MILET 7 TAT 2 FRMER LTV AR CCTFHIEHRE L E T, mkRIE 63 X7 T,
Device Family : 7 74 7> O ET SA A 77 IV TITHREICL > TODHHEIT,
ARX=TNZLET, 74T IPEHALTWDIRILTAAA A 77 IV EBELET,
asa, pix, 721357 XFLURNOT FA XTSI EFRELET,

Device Type : 7 7 A 7 > FOMNET NA A XA T TITIREILR > TWVWDLEEIZ, A
F—T M LET, 7I9A T IBERALTODRILT NS A XA TER/ELET, BE
TEDHHA 71X, pix-515, pix-515e, pix-525. pix-535, asa5505, asa5510, asa5520, asa5540
TY, F£lo, 15 XFUNOTF A MNCFHIEHELET,

Not Specified : 7 74 7> b2 ERICEEY LR WEGEEIC, BIRLET,

o Image Type: A A—¥ XA FZIEELET, ASDM A A —T FE721% Boot £ A—T DT M
T, BT ZDITAT Y M LT 7 A Do D URL Z45E LTS, K 255
i‘(‘\jqo

e Client Revision: Y7 b7 =7 aiR—3R bDUEY g VESIZHINT DT X A b XFF %
BELET, 2271022 0X 5 ITHEELET,

e Image URL: Y7 b7 =7 arKR—%2b®D URL 2RELET, LT, 207 T4 T2 hiC
WL7=77A41DH5 URL ZHEL T EEW,

EF—FK

WO

I, ZoMREEEHNTE T RE R LET,

T7ATFT24—IL E—F

t¥aVTF4 a2TFXFb

=Ty FK iR

RILF
v aAVTEALG

\"
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